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Purpose: 
 
The purpose of this module is to acquaint the participants with the basic concepts of 
information and communication technology so that the participants can use ICT in 
their daily life to enhance their daily office works and improve their performance. 
Besides, it is also necessary for the officers to communicate with the IT department 
for various tasks. This module will also provide them with that capability to effectively 
communicate with the IT department. 
 
 

Delivery and Description: 
 
Methodology:  
This module is designed in such a way that the participants get explicit idea 
regarding the basic ICT terms and concepts. Besides, we also wish that the 
participants will be able to incorporate the facilities of ICT in their everyday life to 
enhance their official works. To achieve this objective, we have made the sessions 
based on the most important topics of ICT that are used in everyday life. We have 
included sufficient practical exercises to ensure that the participants not only learn 
how to use ICT, but they can also implement them. 
 
 
Key learning outcomes: 
After attending the training, the participants will have explicit idea on the concepts of 
the Information and Communication Technology, and they will be able to apply this 
knowledge in their respective organization.  
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SESSION 1: HARDWARE 
 

1.1 Hardware Basics 

The concept of hardware revolves around the concepts of the computer 
components, the physical and the tangible components of a computer, e.g. the 
electrical, electronic and mechanical parts that comprise a computer.  
 
 
Computer Working Principle: 
 
 
 
 
 
 
 
Through the input devices, we give data to computer. Computer then analyzes and 
processes that data and then based on that input data, computer provides us with 
output through the output devices. Common input devices include mouse, keyboard 
etc. CPU is a system unit whereas monitor is an output device.  
 

1.2 Personal Computer 

Personal computer (PC), as the name suggests, is meant for personal use, as 
opposed to the server, which is used by a larger number of people simultaneously, 
from different locations, often via terminals. 
 

1.3 Laptop and Tablet PC 

Laptop or tablet PC is used by individuals who have the need to travel with a 
computer or simply use them for aesthetic reasons when computing power is not an 
issue. Laptop computers, as opposed to tablet PCs, more closely resemble a 
personal computer when it comes to data input. Data entry is done via keyboard and 
mouse, while in the case of the tablet PC, data entry is done via touch screen. 
 

1.4 Main Computer Components 

As already stated, computer’s functionality can be divided into: 
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The system unit (case) contains a computer's vital parts. There are two basic types 
of cases: 

• Desktop casing is placed on a desk in a horizontal orientation.  

• Towers come in 3 sizes (mini-tower, mid-tower and full-tower) and it is vertically 
orientated. 
 

Motherboard, MBO is computer's basic circuit, to which all computer components 
are connected, directly or indirectly. Devices are connected to the motherboard 
through a system bus. System bus connects all devices, ensures data flow and 
communication between different devices using predefined protocols. Protocol 
describes a manner in which communication between devices is defined. It enables 
them to address each other and defines how they should look for each other on 
either system bus or network.  
 
Central Processing Unit (CPU or processor) is a central part of a computer (and 
can be referred to as the computer’s “brain”). It manages all other computer parts, 
monitors their mutual communication and performs arithmetic-logical operations. 
Processor speed is measured in hertz (or megahertz or gigahertz). Most famous 
manufacturers for personal computer processors are Intel and AMD.  
 
Cache is a small capacity memory which allows quick access to data. By storing 
data from working memory in cache, the speed of communication between 
processor and RAM is increased. Microprocessors use three levels of fast cache, L1, 
L2 and L3, used to store often used data.  
 
ROM (Read Only Memory) is a type of permanent, internal memory that is used 
solely for reading. BIOS (Basic Input/output System), a program which is located in a 
separate ROM on the motherboard, and defines, as the name suggests, basic 
input/output system, is a good example. Please note that not all BIOS programs are 
stored in ROM.  
 
RAM (Random Access Memory) is a working memory in which analyzed data and 
programs are stored, while computer runs. It allows reading and writing data and is 
deleted/cleared when the computer shuts down.  
 
Hard Disk Drive (HDD) is a place for permanent data storage (it does not 
delete/clear when computer shuts down). Its features are: large capacity, faster 
performance in comparison to optical devices but slower in comparison to RAM and 
are used for permanent data storage. We can distinguish between internal and 
external hard drives. 
 
Soundcard is a device used for sound creation and production by means of 
computer 
speakers. 
 
Graphics card is responsible for image processing and displaying it on a monitor. It 
has its own graphics processor and memory. Image quality depends on the strength 
of these components.  
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Modem enables computers to communicate via telephone lines. They connect 
computers to the Internet.  
 
Connectors or ports are slots visible in the back and the front side of a computer. 
 
Common Input/output Ports 

• Universal Serial Bus (USB) is used to connect various devices (mouse, keyboard, 
USB 

• memory). 

• Serial port is used for example in connecting a mouse (labeled COM1 or COM2). 

• Parallel port is used for connecting a local printer (LPT1 or LPT2). 

• Network port is used for connecting computers to a network. 

• Fire wire - used for connecting computers and audio-video devices (digital cameras, 
etc.). 

 

1.5 Computer Performance 

Factors affecting computer performance: 

• Processor clock speed, amount of cache and number of kernels 

• The amount of installed RAM 

• Graphics card- its memory and processor 

• Clock bus 

• Number of running applications 
 
Applications use computing resources. The processor runs applications and 
performs code that defines applications; therefore, processors get the most workload 
when it comes to running the application. In order for processors to execute the 
application, it is necessary for application code to be loaded into the system memory. 
As a result, running applications take up a certain amount of working memory. The 
more applications are running, the greater the load on the processor and RAM. That 
is why the computer's performance depends on both the processor (clock speed, 
number of cores, cache memory), and the amount of working memory, as well as the 
number of applications running.  
 
Processor speed is measured in hertz (Hz), and due to a large working clock speed 
of today's processors, it is expressed in megahertz (MHz) or gigahertz (GHz). 
Besides the frequency, the processor performance depends on the number of 
operations that the arithmetic-logic unit (ALU) performs in one clock cycle. 
 

1.6 Input and Output Devices 

Input devices: 
 
Mouse is an input device that facilitates work with the graphical user interface (GUI). 
These days, people usually use optical mice.  
 
Keyboard is used for data entry and issuing commands. They can also be wired or 
wireless. 
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Scanner is used to load data (image, text, etc.) from the printed material into a 
computer. The result of scanning is an image, but with special programs, if we scan 
the text, we can get a text as a result. Software used to recognize text from image is 
called a text recognition tool.  
 
Touchpad is used for transmission of hand movement, but unlike working with a 
mouse, the user is the one who determines the position of the cursor by touching the 
touchpad. 
 
Lightpen enables handwriting on screen and can be used as a mouse. It requires an 
appropriate monitor type.  
 
Microphone is a device that converts sound into an electrical signal, which can be 
stored on a computer. It is mainly used for recording sound, communication between 
players in online games, in combination with a web camera in video conferencing, for 
converting voice into text on a computer (speech-to-text processing (e.g., textual files 
or emails), etc. 
 
Webcam is a camera that stores video signal in a format appropriate for video 
transfer over the Internet in Realtime.  
 
Digital camera, unlike analog, stores photographs in digital format. It can be directly 
connected to a computer and photographs can be downloaded. Photograph quality 
is expressed in megapixels. More megapixels mean better quality of photograph, 
however more memory is occupied. 
 
Output Devices 
 
Monitor displays images from the computer, it enables us to see, work and control 
computers. In other words, working on a computer without a monitor would be 
inconceivable. Common types of monitors, with regard to manufacturing technology, 
are the CRT and LCD. CRT monitors have been present on the market for a long 
time, and other technologies are pushing them out. They are based on cathode tube 
technology. LCD monitors use liquid crystal technology. In comparison with CRT 
monitors, LCD monitors use less electrical energy, do not emit radiation and their 
price is higher, however due to smaller dimensions, more attractive design and a 
good picture quality, they are pushing CRT monitors out of the market. Monitor size 
is expressed by the size of screen diagonal and measured in inches (''). Picture 
quality is expressed with the notion of resolution, which is a number of horizontal and 
vertical dots (pixels) (e.g. 1920x1080). 
 
Projector is a device used to project a computer image or other images from 
independent devices, such as DVD players, Blu-ray player, etc. onto canvas or a 
wall. 
 
Printer is a device used for printing data from a computer onto a paper. We 
distinguish between local printer (connected directly to the computer) and network 
printer (connected directly to network using a network card). Also, printers also differ 
according to print technology: dot matrix, laser, inkjet, thermal printer and plotter.   
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SESSION 2: MEMORY AND STORAGE DEVICE 

ROM (Read Only Memory) Previously discussed. 
RAM (Random Access Memory) Previously discussed.  
 

2.1 Measurement units 

Bit (binary digit) is the basic unit used to measure the amount of information. A byte 
or octet contains eight bits. 
 
1 KB (kilobyte)- 1024 B (approx. 1000 B) 
1 MB (megabyte)- 1024 KB (approx. 1000 KB) 
1 GB (gigabyte) -- 1024 MB (approx. 1000 MB) 
1 TB (terabyte) – 1024 GB (approx. 1000 GB) 
 

2.2 Basic types of Storage Devices 

CD (Compact Disc) is an optical disc used for data storage. The standard capacity 
of a CD is 700MB. CD-R is used for reading and writing data onetime-only, while 
CD-RW for reading and writing data multiple times.  
 
DVD (Digital Versatile Disc) is an optical disc which is, due to the larger capacity 
(about 4.7 GB), mostly used for video storage.  
 
Blu-ray disc (BD) - the successor to DVD, is an optical disk storage, it comes in 
different capacities, depending on how many layers it has and the capacity of each 
layer. Currently, the capacity of one layer is between 27 GB and 33 GB, while the 
overall capacity is the product of the number of layers and capacity of each layer. 
(Source used: http://hr.wikipedia.org/wiki/Blu-ray_Disc). 
 
Nero Software is used for writing data from computer/laptop to a CD/DVD/Blu-ray 
Disc. 
 
Memory card is a type of flash memory used to store data in digital cameras, cell 
phones, MP3 players etc.  
 
There is a difference between an internal hard disk drive, which is embedded in the 
computer case, and an external hard disk drive, which is connected to a computer 
by using an appropriate cable or USB port, and is usually used to transfer data from 
one computer to another or for backup. 
 
 
 
 
 
 

http://hr.wikipedia.org/wiki/Blu-ray_Disc
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SESSION 3: SOFTWARE 

Software is, unlike hardware, intangible part of the computer. It consists of a 
sequence of commands, written according to strict rules. Programs are written by 
programmers, in various programming languages.  
 

3.1 Software types:  

Operating system is a program which manages computer hardware. First 
computers did not have operating systems; they had programs that were directly 
loaded into the computer (e.g. punch cards). Today, computers have an operating 
system which gets loaded into the computer's memory during its startup. Computer 
functions are based on its operating system. Within operating system, drivers 
(responsible for the functioning of a computer) and various utility programs 
(responsible for the functionality of a computer) are installed. The most famous 
operating systems are: 
 

1. Linux (Debian, Ubuntu, Fedora, Knoppix,) - open source software 
2. Microsoft Windows (XP, Vista, 7,) - proprietary software 
3. Mac OS X (Cheetah, Panther, Snow Leopard,) - proprietary software 

 

Application Software (Utility programs) are all programs that users use to perform 
different tasks or for problem solving. Users, according to their needs, install the 
appropriate utility software. Computer functions and tasks that computers can 
perform are defined by the installed utility software. Utility software can often cost 
more than computer hardware unless the software is open source. For running “pdf” 
documents, we use ‘Foxit Reader’/ ‘Adobe Reader’, for running music and video files 
we use ‘VLC player’ etc. 
 
Common utility software is: 
Text processing software is used for creating and forming text documents and 
nowadays, they can contain images, charts and tables. Examples of such programs 
are OpenOffice.org Writer (open source software) and Microsoft Word (proprietary 
software). 
 
Spreadsheet calculations software is used for performing various calculations and 
presentation of results in charts. Examples of such programs are OpenOffice.org 
CalcWriter (open source software) and Microsoft Excel (proprietary software). 
 
Software for presentations is used to create professional presentations that consist 
of slides with graphical and textual elements. Such a presentation can afterwards be 
displayed as a "slide show” by using a projector. Examples of such programs are 
OpenOffice.org Impress (open source software) and Microsoft PowerPoint 
(proprietary software).   
 
Software for creating and managing database helps to manage a collection of 
structured data. Examples of such programs are OpenOffice.org Base (open source 
software) and Microsoft Access (proprietary software). Common utility software 
installed on a computer: 
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• Office programs - OpenOffice.org, Microsoft Office 

• Antivirus programs – Avira, Sophos, Kaspersky, Antivir etc. 

• Internet browser: Mozilla Firefox, Microsoft Internet Explorer, Opera, Safari 
etc. 

• Programs for image editing: Adobe Photoshop, Canvas, CorelDraw, Draw etc. 
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SESSION 4: NETWORK 

Computer network is comprised of at least two, connected, by wire or wireless, 
computers that can exchange data i.e. communicate. There are many reasons for 
connecting computers into a network, and some of them are: 
 

• Exchange of data between users that have network access, 

• Access to shared devices, such as network printers, network disks, etc., 

• Enables user communication and socializing, etc.  

• Internet is the most famous and most widespread network with nearly 2 billion 
users and the number of users is still growing. 

 

4.1 Types of Network 

Types of networks according to their size: 
 

• LAN (Local Area Network) - a network that covers a relatively small geographical 
area- it connects computers within a firm or household by wire. 
 

• WLAN (Wireless Local Area Network) - a network that covers a relatively small 
geographical area - it connects computers within a firm or household wirelessly. 
 

• WAN (Wide Area Network)- a network that covers a relatively large geographical 
area - it connects a greater number of computers and local networks. 
 

4.2 Terms: client / server 

Relationship client - server is defined in the following manner: client sends requests 
and server responds to those requests. We can use Internet as the best-known 
example. User's computer, connected to the Internet, sends requests to a certain 
web page (by entering page address into the Internet browser Address bar), and the 
server responds. Web page is loaded into the user's computer Internet browser as a 
result of server response. From this example, we can see that communication 
between client and server depends on connection speed (bandwidth). Since 
bandwidth is limited, the amount of data that can flow through network is limited too. 
Today, for instance, while purchasing access to mobile Internet, you will notice a 
limited amount of data that can be transferred within a package, i.e. amount of 
transferred data is what is charged.  
 
The reason for that is limited bandwidth of mobile networks, and since companies 
that are offering mobile Internet access do not want networks to be congested, they 
de-stimulate their users by charging amounts of money related to the amount of 
transferred data. That was the case with ADSL Internet access. Today, once Internet 
providers have developed communication infrastructure, they do not need to de-
stimulate users by charging based on the amount of transferred data, therefore they 
are offering so called "flat rate" access) charging only based on the access speed. 
That is why you will, while listening or reading news about communication 
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technologies, have the opportunity to hear how important it is to develop 
communication infrastructure. 
 
Types of networks according to their architecture:  

• client-server - all clients are connected to the server. 

• P2P (peer to peer) - all computers are clients and servers at the same time. 
 

4.3 Internet / Intranet / Extranet 

Internet ("network of all networks") is a global system comprised of interconnected 
computers and computer networks, which communicate by means of using TCP/IP 
protocols. 
 
An intranet is a private network that is contained within an enterprise. It may consist 
of many interlinked local area networks and also use leased lines in the wide area 
network. Typically, an intranet includes connections through one or 
more gateway computers to the outside Internet. The main purpose of an intranet is 
to share company information and computing resources among employees. An 
intranet can also be used to facilitate working in groups and for teleconferences. 
 
An extranet is a private network that uses Internet technology and the public 
telecommunication system to securely share part of a business's information or 
operations with suppliers, vendors, partners, customers, or other businesses. An 
extranet can be viewed as part of a company's intranet that is extended to users 
outside the company. It has also been described as a "state of mind" in which the 
Internet is perceived as a way to do business with other companies as well as to sell 
products to customers. 
 

4.4 Data Flow / Transfer  

Download is a term that implies taking a copy of digital data from a network 
computer on a local computer, and upload means placing digital content on a 
network computer. Bitrate represents speed at which data is transferred through a 
modem (network). It is measured in bit/s (bit per second). Bit/s is a measurement 
unit for speed of digital data flow through the network. The number of bits transferred 
in one second tells us how many bits can be transferred through a network in one 
second.  
 

• 1,000 bit/s rate = 1 kbit/s (one kilobit or one thousand bits per second) 

• 1,000,000 bit/s rate = 1 Mbit/s (one megabit or one million bits per second) 

• 1,000,000,000 bit/s rate = 1 Gbit/s (one gigabit or one billion bits per second) 
 
Speed of data flow can be expressed in bytes per second. Since one byte has eight 
bits, such is the relation between bit/s and Bp/s, i.e. bits per second and bytes per 
second. 
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4.5 Ways to connect to the Internet:  

➢ Dial-up Internet access method uses a modem (56k) and a telephone line. 
➢ Broadband is characterized by a high-speed data transfer, permanent access 

to 
the Internet, and thus the risk of unauthorized access to the network or your 
personal computer. In the beginning of broadband Internet access, due to 
underdeveloped communication infrastructure, Internet providers charged 
based 
on the data traffic but not time spent on the Internet (unlike dial-up Internet 
access). Today, in large cities, telecommunications infrastructure is 
developed,  
therefore Internet providers do not charge money based on the time spent on 
the 
Internet or the amount of transferred data but they do charge by access 
speed. 

➢ Mobile connecting by using a mobile network (GPRS, EDGE, UMTS, HSPA). 
➢ Wireless (Wi-Fi) - data is transferred between computers by using radio 

frequencies (2,4 GHz) and the corresponding antennas. For Wi-Fi connection 
at home, we use router. 

➢ Cable - connecting to the Internet through television cable network using a 
cable 
modem. 
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SESSION 5: DATA SECURITY 

Information security is defined as:  

• Preservation of information confidentiality, integrity and availability 

• Information security measures are the rules of data protection on physical, 
technical and organizational level. 

 
User authentication involves user identification, so individuals can gain access to a 
certain content (data). For example, to check e-mail via browser, i.e., access an 
account, it is necessary to enter a username and password. If the required 
information is entered correctly, access is granted. Passwords should, for security 
reasons, be kept confidential. Password is a key (like a key to access your home or 
a car) that allows access. As you would not share your apartment or car keys with 
just anyone, you should not share your password either. Nowadays, many people 
have home security doors with locks whose keys are difficult to copy, with the aim of 
blocking unauthorized home intrusion. Passwords should be created with the same 
caution. The more complex your password is, the harder it will be to break through 
(crack it), therefore it is less likely that someone will gain unauthorized access to 
your data. When choosing a password, it is advisable to use punctuation, numbers 
and a mix of uppercase and lowercase letters. A minimum length of 8 characters is 
recommended (shorter passwords are easier break through). From time to time, it is 
necessary to change the password. That way, the possibility of its detection 
decreases. Some of the most common mistakes when choosing passwords are:  
 

• Using words from a dictionary 

• Passwords based on personal information, such as name or birth date, 
employment place etc. 

• Characters that follow the order given on a keyboard: 123, qwert, etc. 
 
How to choose a good password: 

• Select a sentence: e.g. The world is a beautiful place to live in. 

• Take the first letters, i.e.: TwIabPtLi 

• Add numbers: for example, Twlab3Pt7Li 
 
This password has a combination of numbers, uppercase and lowercase letters and 
11 characters. Thus, this is password is difficult to break through. 
 

5.1 Data Backup 

All of us do lots of important works in our computer and save them. We might think 
that our data is safe in the computer. But it might happen that your computer system 
crashes and thus you will have to lose all your important data that took a lot of effort 
to be created. To circumvent this situation, we can create a backup copy of our data 
and save it in some other ‘devices’. Some of us might think that by the word ‘Device’, 
we are implying to use another computer or laptop that is usually costly to save data. 
For saving the backup copy of your data, you won’t have to buy another computer or 
laptop. We can use portable hard disc drive for saving our data. Usually, portable 
hard disc drives can store 1 terabytes of data or more. Besides, the top IT 
companies like Microsoft and Google also provide the option of saving your data in 
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their server so that you can retrieve them from anywhere you want just by logging 
into their account. For example, Google has created “Google Drive” which is a cloud-
based file storage service through which you can save your important files on 
Google’s servers. Google allows us to save at most 15 gigabytes of data to store on 
their servers without any cost. If you need to store more than 15 gigabytes of data, 
then you have to purchase storage from them, and they have got customer friendly 
pay plans. Besides, “Dropbox” is another file storage platform.  
 
The other popular method of data storage is CD/DVD. Usually, DVDs have a higher 
data storage capacity that is of 4.7 gigabyte whereas CDs have a low data storage 
capacity that is of 700 megabytes. 
 

5.2 Data Security  

Firewall is a software (or network device) that is used to control authorized access 
and protect against unauthorized access to your computer. Figuratively speaking, 
computers are connected via network port. In the computer world, the term port is 
used to describe the network of connections through which computers can connect 
to a computer network, or someone can connect to your computer from outside of 
your network. All data traffic between a computer and the rest of network is done 
through ports. Control port controls data flow from our computers to the network and 
vice versa. Control is done through a firewall; some ports are opened, some closed, 
and some allow temporary traffic. To protect data from unauthorized access and 
theft, we use a username and password to confirm our identity and prevent 
unauthorized data access. Similarly, in case we need to briefly step away from a 
computer, it is necessary to lock it.  
 

5.3 Malware 

Malware (malicious + software) is a software, which infiltrates an operating system in 
a seamless manner, whether by human mistake or due to shortcomings of the 
operating system and software support, with malicious intentions. Malicious software 
includes: 
 

✓ Virus is a malicious program with the possibility of self-replication. In a 
computer 
it seeks other files, trying to infect them and the ultimate goal is to spread to 
other computers. Depending on what malicious code it contains, it may cause 
more or less damage to your computer. 

✓ Worms like viruses, they possess the ability of self-replication, and however 
they 
cannot infect other programs. Their usual intent is to take control of your 
computer and allow remote control by opening, the so-called, 'backdoor'. 

✓ Trojan horses can be presented in the form of games or files in e-mail 
attachments, with different purposes, such as: to allow remote control to your 
computer, delete data, allow spreading of viruses, send spam from the 
infected 
computer, etc. Unlike viruses and worms, it does not replicate, and it needs to 
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be 
executed, that is, it is not autonomous. 

✓ Spyware is a program that secretly collects data about computer users 
(passwords, credit card numbers, etc.), therefore it spies on users. The most 
common spyware infections usually occur while visiting suspicious sites with 
illegal or pornographic content. 

✓ Adware is a program that uses collected data about a user in order to display 
advertisements in a way regarded as intrusive. It usually manifests itself in the 
form of many pop-up windows that display ads. 

✓ Hoax is a false message being spread by e-mail in order to deceive users. 
Their 
goal is to obtain data of, for instance, a bank account, or persuade users to 
pay 
some fees in order to win the lottery (which they never applied for), or pay 
costs 
of money transfers from an exotic prince to help him withdraw money from a 
country that is falling apart and, in return, will receive an impressive award, 
etc. 

 
In order to demystify malicious programs, it is necessary to explain that malicious 
software is nothing more than a computer program. Like any other computer 
program, it must be installed on your computer (operating system) to act. Without 
making the distinction between malignant and benign programs, let us think of them 
as just a computer program. 
 
Taking this into consideration, ask yourself the following questions:  
✓ Question: How can I install a computer program?  

Ans: We must have a program installation/update file.  
✓ Question: How can I get software installation?  

Ans: Installations are available on CD/DVD, USB stick, network drive, the 
Internet (need to be downloaded), in electronic mail, etc. i.e. through 
any electronic medium capable of storing and distributing digital data. 

 
From these questions and answers, it is evident how you can become infected by 
malicious programs. Unlike legal and non-malicious programs, malicious programs 
are designed in a way that they do not have to be looked for, i.e. you do not need to 
search for them, you do not need to have any computer knowledge to install them, 
indeed, the less you know, the better it is for them. So, the more you know, the more 
likely it is that you will be safe from an infection, with the use of professional 
protection programs against malicious programs. Therefore, to evade getting 
attacked by the malwares, we should follow the following steps: 
 
✓ We can use good antivirus programs like Kaspersky, Avast, Bitdefender, Norton 

etc. 
✓ Try to gain as much ICT knowledge as you can so that no one can outwit you 

while using technology. 
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SESSION-6: WEB BROWSING AND 

COMMUNICATION 

In our day-to-day life, we are confronted with many problems that can easily be 
solved through the help of internet. These problems are not only regarding ICT, but 
they also concern our day-to-day life, works, business etc. For example, there is a 
platform named ‘Quora’ where you can ask any question you want that is concerning 
anything like politics, cricket, entertainment, ICT etc. In this session, we shall 
introduce you how to solve your everyday life’s problems using Internet rather than 
seeking help from other people.  
 
Whenever we encounter any problem, the first point that should come to our mind is 
to find the solution of that problem on the Internet. This work is termed as “Google it”. 
It means that whenever you encounter any problem, find the problem’s solution 
through Google, because in these days, almost all the problems’ solutions are 
posted on Internet and Google will help you find that solution.  
 
To find any problem’s solutions on the Internet, you need to get your device 
connected to the network first. Then open any browser. The most commonly used 
browsers are Google Chrome and Firefox. After that, you might select your favourite 
search engine, but it is not necessary since you can search in any of the search 
options. When I open my Google Chrome browser, I get the following interface and I 
have marked the options where you can place your query or search. 
 

 
 
 
Now, we discuss some ICT related problems and their solutions below. 
 
While downloading and installing softwares, we often need to know whether our 
laptop/personal computer is a 64-bit or 32-bit device. To solve this problem, just do a 
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search on “how to know computer 64-bit or 32-bit”. For doing this search on my 
computer, I get the following result: 
 

  
 
Several websites will follow the search box and you have to go the websites to find 
the answer to your problem. 
 
To find solution to any problem, find out the appropriate query and then place it in 
the search box. After that, several websites will follow, and you need to go to the 
websites to find the solution to your problem. You may have to check several 
websites for finding the solution. 
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SESSION-7: ICT IN EVERYDAY LIFE 

The acronym ICT (Information and Communication Technology) includes all 
technical means that are used for handling information and facilitating 
communication, including computers, network hardware, communication lines and all 
the necessary software. In other words, ICT is comprised of information technology, 
telephony, electronic media, and all types of process and transfer of audio and video 
signals, and all control and managing functions based on network technologies. 
 

7.1 Internet services 

 
E-commerce is a form of trade that allows customers to browse and purchase 
products online.  
 
E-banking allows users to have control over their accounts (view balances and 
transactions), transactions from one account to another, credit payment, shopping 
vouchers for mobile phones etc. The benefits are saving time (which would 
otherwise be spent waiting in lines), lower service fees, and access from anywhere, 
anytime. 
 
E-government is the use of information technology to provide better public access 
to government information, therefore providing citizens with their human right to 
information. 
 
Teleworking means the use of information technology (IT) 
and telecommunications to replace work-related travel. Teleworking allows 
employees to work at home or at a local telework center for one or more days per 
week using communication tools, such as phone, fax, modem, Internet 
teleconferencing, e-mail or IM, to perform work duties from a remote location. 
Teleworking is also known as telecommuting. 
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SESSION-8: MICROSOFT OFFICE 

Microsoft Office (or simply Office) is a family of client software, server software, and 
services developed by Microsoft. It was first announced by Bill Gates on August 1, 
1988, at COMDEX in Las Vegas. It contains several useful software for official and 
academic purposes. The names of the software that the Microsoft Office package 
contains are: 
 

❖ Microsoft Word: a word processor included in Microsoft Office. It is the most 

used software for writing reports, letters, applications etc. 

❖ Microsoft Excel: a spreadsheet editor. It is used for preserving and analysing 

data. 

❖ Microsoft PowerPoint: a presentation program used to create slideshows 

composed of text, graphics, and other objects, which can be displayed on-

screen and shown by the presenter or printed out on transparencies or slides. 

❖ Microsoft Access: a database management system for Windows that 

combines the relational Microsoft Jet Database Engine with a graphical user 

interface and software development tools. 

❖ Microsoft Outlook: a personal information manager that includes an email 

client, calendar, task manager and address book. 

❖ Microsoft OneNote: a note taking program that gathers handwritten or typed 

notes, drawings, screen clippings and audio commentaries. 

There are several other applications in the Microsoft office package, but the most 
used ones are Microsoft Word, Microsoft Excel and Microsoft PowerPoint.  
 

8.1 Microsoft Word 

Microsoft Word is a word processing application that allows you to create a variety of 
documents, including letters, resumes, and more. The default file format of Microsoft 
Word is ‘docx’. In this lesson, you'll learn how to navigate the Word interface and 
become familiar with some of its most important features, such as the Ribbon, Quick 
Access Toolbar, and Backstage view. 
 

8.2 The Word Interface 

When you open Word for the first time, the Start Screen will appear. From here, 
you'll be able to create a new document, choose a template, and access your 
recently edited documents. From the Start Screen, locate and select Blank document 
to access the Word interface. 
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Working with the Word Environment 
All recent versions of Word include the Ribbon and the Quick Access Toolbar, where 
you'll find commands to perform common tasks in Word, as well as Backstage view. 

 
The Ribbon 
Word uses a tabbed Ribbon system instead of traditional menus. 
The Ribbon contains multiple tabs, which you can find near the top of the Word 
window. 
 

 
 
 
Each tab contains several groups of related commands. For example, the Font group 
on the Home tab contains commands for formatting text in your document. 
 

 
 
Some groups also have a small arrow in the bottom-right corner that you can click for 
even more options. 
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Backstage view 
Backstage view gives you various options for saving, opening a file, printing, and 
sharing your document. To access Backstage view, click the File tab on the Ribbon. 
 

 
 
Click the buttons in the interactive below to learn more about using Backstage view. 
 

 
 
Word: Creating and Opening Documents 
Word files are called documents. Whenever you start a new project in Word, you'll 
need to create a new document, which can either be blank or from a template. You'll 
also need to know how to open an existing document. 
 
To create a new blank document, carry out the following steps: 
 
When beginning a new project in Word, you'll often want to start with a new blank 
document. 

1) Select the FILE tab to access backstage view.  
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2) Select New, then click the Blank Document. Several other beautiful templates will 

appear below the Blank Document option and you can also select them. 

 
 

3) A new blank document will appear. 

 
Text Basics 
 
Now, you will learn the basics of typing, editing, and organizing text. Basic tasks 
include the ability to add, delete, and move text in your document, as well as how to 
cut, copy, and paste. 
 
The insertion point is the blinking vertical line in your document. It indicates where 
you can enter text on the page. 

 
 
Before you can move or format text, you'll need to select it. To do this, click and drag 
your mouse over the text, then release the mouse. A highlighted box will appear over 



Page | 25  
 

the selected text. The text has been selected. Then if you click on the right click of 
the mouse, some options will appear before you. 

 
 
Copying and Moving Text 
 
Word allows you to copy text that's already in your document and paste it in other 
places, which can save you a lot of time and effort. If you want to move text around 
in your document, you can cut and paste or drag and drop. 
To copy and move text: 

1) Select the text that you want to copy. 

2) Press Ctrl+C to copy the text. 

3) Place the insertion point where you want the text to be placed now. 

4) Press Ctrl+V to place the text in your desired point. 

 
Undo and Redo 

 
Let's say you're working on a document and have accidentally deleted some text. 
Fortunately, you won't have to retype everything you just deleted! Word allows you to 
undo your most recent action when you make a mistake like this.  
 
To do this, press Ctrl+Z on your keyboard. You can continue using this command to 
undo multiple changes in a row. 
 
By contrast, the Redo command allows you to reverse the last undo. You can also 
access this command by pressing Ctrl+Y on your keyboard. 

Inserting symbols: 
 
To insert a symbol, carry out the following steps: 
 

1) Place the insertion point on the part of the document where you want the 

symbol to appear. 

2) Click the INSERT tab on the ribbon. 

3) On the INSERT tab in ribbon, you will find your desired symbol. 

 
4) If you can’t find your expected symbol, then click on ‘More Symbols’ to find 

your symbol. 
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List Creation 
Sometimes, you might need to insert list in your document. To insert a list: 

1) Select the text that you want to be in the list form. 

2) Select the HOME tab on the ribbon. 

3) Under the Paragraph group, the list options will appear. 

4) Choose your favourable type of list. 

8.3 Microsoft PowerPoint 

PowerPoint is a presentation program that allows you to create dynamic slide 
presentations. These presentations can include animation, narration, images, videos, 
and much more. The most common type of PowerPoint files is ‘pptx’ and ‘ppt’. In this 
lesson, you'll learn your way around the PowerPoint environment. 
 
When you open PowerPoint for the first time, the Start Screen will appear. From 
here, you'll be able to create a new presentation, choose a template, and access 
your recently edited presentations. From the Start Screen, locate and select Blank 
Presentation to access the PowerPoint interface.   

 
The Ribbon is the place where you will find all your required commands to make a 
PowerPoint presentation. PowerPoint uses a tabbed Ribbon system instead of 
traditional menus. The Ribbon contains multiple tabs, each with several groups of 
commands. For example, the Font group on the Home tab contains commands for 
formatting text in your document. Some groups also have a small arrow in the 
bottom-right corner that you can click for getting more options. 
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The Backstage View provides us with the options for saving, printing, opening and 
sharing our presentations. To access the Backstage view, click the File tab on the 
ribbon that is on the top left corner. The usual interface of the Backstage View is 
provided below. From the Backstage View, you can also get the basic information 
like the number of slides, size, author, related dates of the file on which you are 
working. 

 
Whenever you start a new project in PowerPoint, you'll need to create a new 
presentation, which can either be blank or from a template. 
 
To create a new presentation: 

1. Select the File tab to go to Backstage view. 

 

2. Select New on the left side of the window. From here, you can choose a Blank 

Presentation. Rather than choosing a blank presentation, you can choose 

from thousands of beautiful templates for your presentation. 

                

3. A new presentation will appear. 
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Every PowerPoint presentation is composed of a series of slides. To begin creating a 
slide show, you'll need to know the basics of working with slides. You'll need to feel 
comfortable with tasks like inserting a new slide, changing the layout of a slide, 
arranging existing slides, changing the slide view, and adding notes to a slide. 

 
To insert a new slide: 
Whenever you start a new presentation, it will contain one slide with the Title Slide 
layout. You can insert as many slides as you need from a variety of layouts. 

1. From the Home tab, click the bottom half of the New Slide command. 

 
 

2. Choose the desired slide layout from the menu that appears. 

 

3. The new slide will appear. Click any placeholder and begin typing to add text. 

You can also click an icon to add other types of content, like a picture or chart. 

 

4. To change the layout of an existing slide, click the Layout command, then 

choose the desired layout. 

PowerPoint presentations can contain as many slides as you need. The Slide 
Navigation pane on the left side of the screen makes it easy to organize your slides. 
From there, you can duplicate, rearrange, and delete slides in your presentation. 
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Duplicate slides: If you want to copy and paste a slide quickly, you can duplicate it. 
To duplicate slides, select the slide you want to duplicate, right-click the mouse, and 
choose Duplicate Slide from the menu that appears. You can also duplicate multiple 
slides at once by selecting them first. 
 
Move slides: It's easy to change the order of your slides. Just click and drag the 
desired slide in the Slide Navigation pane to the desired position. 

 
Delete slides: If you want to remove a slide from your presentation, you can delete it. 
Simply select the slide you want to delete, then press the Delete or Backspace key 
on your keyboard. 
 
 
Adjusting Placeholders 

• To select a placeholder: Hover the mouse over the edge of the placeholder 

and click (you may need to click the text in the placeholder first to see the 

border). A selected placeholder will have a solid line instead of a dotted line. 

 
• To move a placeholder: Select the placeholder, then click and drag it to the 

desired location. 
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• To resize a placeholder: Select the placeholder you want to resize. Sizing 

handles will appear. Click and drag the sizing handles until the placeholder is 

the desired size. You can use the corner sizing handles to change the 

placeholder's height and width at the same time. 

 
• To delete a placeholder: Select the placeholder you want to delete, then press 

the Delete or Backspace key on your keyboard. 

 

8.4 Microsoft Excel 

Excel is a spreadsheet program that allows you to store, organize, and analyze 
information. While you may think Excel is only used by certain people to process 
complicated data, anyone can learn how to take advantage of the program's 
powerful features. Whether you're keeping a budget, organizing a training log, or 
creating an invoice, Excel makes it easy to work with different types of data. 
 
When you open Excel for the first time, the Excel Start Screen will appear. From 
here, you'll be able to create a new workbook, choose a template, and access your 
recently edited workbooks. 
 
From the Excel Start Screen, locate and select Blank workbook to access the Excel 
interface. 

 
Like the other Microsoft Office software’s, Excel has a Ribbon where you can find the 
options that you can employ in your spreadsheet works. Excel also has the 
Backstage View from where you can save, print, open and share your workbooks. 
 
Excel files are called workbooks. Whenever you start a new project in Excel, you'll 
need to create a new workbook. There are several ways to start working with a 
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workbook in Excel. You can choose to create a new workbook—either with a blank 
workbook or a predesigned template—or open an existing workbook. To create a 
new blank workbook, go to the Backstage View from the File tab and from there, you 
will have the option to choose a new blank workbook or a predesigned template. 
 
Cell Basics 
When we work with Excel, we enter information or content into cells. Cells are the 
basic building blocks of worksheet. 
 
Every worksheet is made up of thousands of rectangles, which are called cells. A cell 
is the intersection of a row and a column. To select a cell, you just need to click it. 
 
Columns are identified by letters (A, B, C), while rows are identified by numbers (1, 
2, 3). Each cell has its own name—or cell address—based on its column and row. In 
the example below, the selected cell intersects column C and row 5, so the cell 
address is C5. 

 
Note that the cell address also appears in the Name box in the top-left corner, and 
that a cell's column and row headings are highlighted when the cell is selected. 
 
You can also select multiple cells at the same time. A group of cells is known as a 
cell range. Rather than a single cell address, you will refer to a cell range using the 
cell addresses of the first and last cells in the cell range, separated by a colon. For 
example, a cell range that included cells A1, A2, A3, A4, and A5 would be written as 
A1:A5. 
 
Any information you enter into a spreadsheet will be stored in a cell. Each cell can 
contain different types of content, including text, formatting, formulas, and functions. 
 
One of the most powerful features in Excel is the ability to calculate numerical 
information using formulas. Just like a calculator, Excel can add, subtract, multiply, 
and divide. In this lesson, we'll show you how to use cell references to create simple 
formulas. 
 
Mathematical operators:  Excel uses standard operators for formulas, such as a plus 
sign for addition (+), a minus sign for subtraction (-), an asterisk for multiplication (*), 
a forward slash for division (/), and a caret (^) for exponents. 
 
All formulas in Excel must begin with an equal’s sign (=). This is because the cell 
contains, or is equal to, the formula and the value it calculates. 
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While you can create simple formulas in Excel manually (for example, =2+2 or =5*5), 
most of the time you will use cell addresses to create a formula. This is known as 
making a cell reference. Using cell references will ensure that your formulas are 
always accurate because you can change the value of referenced cells without 
having to rewrite the formula. 

 
By combining a mathematical operator with cell references, you can create a variety 
of simple formulas in Excel. Formulas can also include a combination of cell 
references and numbers, as in the examples below: 
 

 
 
 
To edit a formula: 
Sometimes you may want to modify an existing formula. In the example below, we've 
entered an incorrect cell address in our formula, so we'll need to correct it. 

1. Select the cell containing the formula you want to edit. In our example, we'll 

select cell B3. 
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2. Click the formula bar to edit the formula. You can also double-click the cell to 

view and edit the formula directly within the cell. 

 
3. A border will appear around any referenced cells. In our example, we'll 

change the second part of the formula to reference cell B2 instead of cell C2. 

 
4. When you're finished, press Enter on your keyboard or click the checkmark in 

the formula bar. 

 
5. The formula will be updated, and the new value will be displayed in the cell. 
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SESSION 8: DISCUSSION AND QUESTION 

ANSWER 

Basic ICT usage will be discussed 
 

• Summary of the module 

• Way forward 
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